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Module 3 : 
Définir les scénarios de mise en œuvre des actions 

 

OBJECTIFS 

L'objet de ce module est de définir une méthodologie d'évaluation des projets repérés dans les 
modules précédents en articulant les deux niveaux de l'analyse, l'échelon des entreprises et l'échelon 
territorial. La méthodologie cherche à formaliser les différentes étapes de la prise de décision, en 
tenant compte des critères proposés par les différents partenaires (analyse technico-économique, 
analyse des risques, analyse environnementale) tout en les replaçant dans un contexte territorial. 

 
La première étape concerne l'évaluation ex ante des scenarii. Pour ce faire, des indicateurs 
permettant de prendre en compte les externalités territoriales sont nécessaires. Une méthodologie de 
construction des indicateurs est développée, partant des acteurs, de leurs réseaux, et des processus 
de coordination qu'ils mettent en œuvre. Une grille d'indicateurs est construite, qui suit au plus près la 
démarche concrète d'entreprise.  
Cette grille classe les indicateurs en quatre grands thèmes (2 pour les entreprises, 2 pour les 
territoires) : flux de matière et d'énergie en entrée et sortie du système synergétique ; fonctionnement 
de la synergie créé par la démarche ; développement territorial ; et intégration environnementale. Un 
exemple illustre la démarche de l'évaluation. 

Une deuxième étape intègre ces différents critères dans une analyse multicritère.  L'analyse 
multicritère est un outil d'aide à la décision qui permet de prendre en compte les différents enjeux pour 
les parties prenantes et leur territoire. Les critères proposés, pré-construits (ou éventuellement  
choisis par les acteurs) permettent de comparer les scenarii pour les classer et identifier les points de 
convergence ou de divergence. Deux exemples illustrent l'utilisation de cette méthode d'analyse. 

Dans un dernier temps, un Système d'Information Géographique complète cette méthodologie. Il 
permet une visualisation cartographique des différents éléments d'analyse pouvant être géo-
référencés. En sus, diverses modalités d'extension des informations disponibles par le SIG sont 
présentées. 

A l'issue de ce module, le porteur de projet est en mesure d'envisager les actions à mettre en œuvre 
pour permettre le développement de l'écologie industrielles sur le territoire. La définition de la stratégie 
territoriale devra prendre en compte les différents éléments de l'évaluation et de l'analyse multicritères 
pour permettre une planification sur le moyen voire le long terme des actions à mener favorisant la 
démarche. De plus, certains outils d'animation et de pérennisation de la démarche lui seront 
particulièrement utiles pour en assurer la pérennité. 

METHODE  

La méthodologie comprend 5 étapes: 

Fiche action 16 :  Définition du contexte de la prise de décision 
Cette phase du projet consiste en une évaluation synthétique, une validation et une formalisation des 
actions étudiées jusque là (Modules 1 et 2). 

Fiche action 17 : Évaluation globale des actions ét udiées et/ou sélection d'indicateurs pour 
l'analyse multicritère , sélection des indicateurs de l'évaluation, issus des outils d'analyse de 
faisabilité et d'impact, d'une part et d'une batterie d'indicateurs de développement durable, d'autre 
part. Ils sont choisis en collaboration entre les parties prenantes de l'action à mener ou du projet dans 
son ensemble. 
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Fiche action 18 : De l'analyse multicritère aux scé narios de mise en œuvre , les critères 
sélectionnés sont caractérisés et renseignés dans le logiciel d'analyse multicritère (dans les tests, une 
version d'essai du logiciel Decision Lab a été utilisée). Ce dernier peut être utilisé de deux manières : 

- En amont, pour identifier les critères finalement décisifs au sens des décideurs dans le choix de telle 
ou telle action (en faisant varier la pondération des critères) ; 
- En aval, pour opérer un classement et comparer diverses actions envisagées (synergies ou 
modalités de synergies) selon les critères renseignés. 

Fiche action 19 : Cartographie des scénarios d'acti ons envisagés  
L'utilisation d'un Système d'Informations Géographiques (SIG) dans un projet d'écologie industrielle 
permet de cartographier le territoire, les acteurs de la démarche, les flux et les synergies potentielles. 

 
Fiche action 20 :  Prise de décision et définition d'un plan d'action  
Les résultats obtenus (scenarii préférentiels et cartographie des actions retenues), une fois 
sélectionnés, sont soumis à discussion avec les parties prenantes concernées, au sein de l'entreprise 
et/ou du comité de pilotage du projet à l'échelle territoriale. 
 
Outils et supports associés 

 
La méthodologie repose sur l'articulation de 3 outils  complémentaires : 

"    Grille d'indicateurs de développement durable pour l'écologie industrielle  

"    Outil d'analyse multicritère et son tutorial 

"    Outil SIG Manifold® et son tutorial 

Le Module 3 mobilise également des informations et des données issues des Modules 1 et 2: 

- Base de données issue des bilans de flux: cf. Fiche Action 7 
- Base de données, notations et critères issus des analyses de faisabilité/impact: cf. Module 2, Fiches 
Actions 11 à 15 
- Information sur les jeux et réseaux d'acteurs locaux: cf. Fiche Action 5 

CONTACTS MODULE 3: 

Analyse multicritère, méthodologie et outils: Clersé 

Indicateurs de développement durable pour l'EI: Clersé 

Outil SIG et son tutorial: Auxilia 
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Fiche action 16:  
Définition du contexte de la prise de décision 

OBJECTIFS 
Cette phase du projet consiste en une évaluation synthétique, une validation et une formalisation des 
actions étudiées jusque là (modules 1 et 2). Il convient donc dans un premier temps de définir le 
contexte et les modalités de la prise de décision. Il faut d’abord recenser les différentes actions 
envisagées pour lesquelles des études de faisabilité ont été menées et leurs résultats, et les parties 
prenantes de ces actions.  

Le pilote de l’action ou de la démarche d’ensemble coordonne activement ces parties prenantes. En 
effet, la sélection des critères d’évaluation des actions, leur évaluation (par exemple le paramétrage 
du logiciel d'analyse multicritère), et in fine la prise de décision, doivent dans la plupart des cas 
s’effectuer de manière partenariale (Fiches action 17 à 20).  

METHODE 
Le pilote de l’action étudiée ou le comité de pilotage et les entreprises concernées définissent les 
actions à évaluer et comparer. Deux cas de figure sont envisageables : 

- il s’agit de prioriser les actions dont la faisabilité est avérée en fonction de leur intérêt pour les 
entreprises concernées ou le territoire. L’évaluation et l’analyse multicritère sont des outils 
d’aide à la décision dans la sélection et la hiérarchisation des actions. 

- le comité a une préférence préétablie sur la ou les synergies à développer. Dans ce cas, 
l’évaluation ou l'analyse multicritère permettront de dégager les forces et faiblesses des 
différents scenarios de mise en œuvre et de renforcer l’argumentation pour le projet.  

OUTILS 
Fiches actions 17 à 20 et outils associés 

ILLUSTRATION  
Sur le territoire dunkerquois, l’inventaire des flux (module 1) a montré que plusieurs entreprises gèrent 
leurs déchets fermentescibles isolement. Les déchets issus soit de l’activité même des entreprises 
agroalimentaires soit de la restauration d’entreprises suivent trois différentes filières de traitements : ils 
sont enterrés ou incinérés sans valorisation ; ils sont collectés par un prestataire éloigné qui les 
revalorise hors du territoire ; enfin, ils sont valorisés dans une usine de méthanisation sur le territoire 
qui récupère le méthane issu de la fermentation et fournit les agriculteurs locaux en matières 
organiques pour l’épandage. Aujourd’hui, cette usine fonctionne en sous capacité par manque de 
matière fermentescible.  

Sur ce territoire, il existe une association d’entreprises, ECOPAL dont le cœur d’activité est la 
promotion de l’écologie industrielle. Elle a démarché les entreprises concernées pour organiser une 
collecte mutualisée des déchets fermentescibles et les valoriser dans l’usine de méthanisation locale. 
En tant que porteuse de l’intérêt commun, les deux objectifs principaux affichés de l’association sont : 
la réduction du nombre de camions de collecte et l’augmentation de l’activité de l’usine de 
méthanisation et ce à moindre coût pour les entreprises concernées. 

 

Pour l’association ECOPAL, qui coordonne l’étude du projet, les outils proposés dans cette fiche 
permettent : 

- de dégager les acteurs potentiellement intéressés par la démarche (analyse du jeu d’acteurs) 
- de discuter avec eux, les attentes et intérêts de chacun et les intérêts communs  
- de commencer à réfléchir sur les indicateurs pour l’évaluation / pour l’analyse multicritère 
- de repérer, avec le SIG, les difficultés géographiques éventuelles  
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Fiche action 17:  
Evaluation globale des actions étudiées et/ou sélec tion 

d’indicateurs pour l’analyse multicritère 

OBJECTIFS 
Après avoir étudié la faisabilité des actions envisagées (Module 2), et avant de les mettre en place, les 
décideurs doivent pouvoir évaluer ex ante chacune de ces actions. A ce stade, il faut dégager une 
analyse globale des avantages et inconvénients  des scenarios de mise en œuvre. Les indicateurs 
proposés ici peuvent permettre d’opérer une nouvelle sélection des actions et/ou des  modalités 
de mise en œuvre . Si besoin, on pourra ensuite les évaluer plus finement grâce à l’outil d’analyse 
multicritère proposé dans ce module, à l’appui de cette même batterie d’indicateurs , afin d’acter 
l’engagement ou non de ces actions (« go / no go ») et de définir un plan d’action. 

METHODE 
Dans ce module, les différents indicateurs que nous proposons sont issus soit des étapes 
précédentes de la méthodologie (module 1 et 2), soit d’une revue bibliographique des indicateurs en 
écologie industrielle, développement durable ou encore de l’évaluation de la biodiversité et des 
services éco-systémiques. Ces indicateurs sont classés  en quatre grands thèmes  qui suivent la 
logique d’un élargissement du périmètre de la synergie vers le territoire :  

- fonctionnement de la synergie  
- réduction des flux en entrée et sortie (du système synergétique)  
- développement territorial  
- intégration environnementale 
 

Le choix des indicateurs est le fruit d’une discuss ion entre les parties prenantes  de l’action. 
D’autant plus qu’il semble important que les enjeux majeurs des principales parties prenantes soient 
pris en compte dans cette évaluation afin d'assurer l'implication de chacun. Ainsi pour n’oublier aucun 
des aspects de l’action et considérer également ses externalités, il est conseillé de sélectionner au 
moins un indicateur par thème et de prend en compte les différents niveaux d’intérêts.  

 
Exemples d’indicateur pour chacun des thèmes (extra it du tableau d’indicateurs) : 
 

OUTILS 
Classeur EXCEL avec : 

- une feuille présentant les indicateurs et les définissants avec des filtres pour l'aide au choix de 
critère ;  

- un mode d’emploi pour l’utilisation du tableau d’indicateurs. 

Thèmes Sous-thèmes Nom  de  

l'indicateur

Description Liens  dans la 

méthodologie

périmètre de 

l'intérêt

Mode de calcul Métrique/Unit

é
Développement 

territorial

Impact 

économique

Évolution de l’emploi Evaluation de la création 

des emplois  générés par 

l'activité d'un système 

synergétique

Intérêt général emplois créés - 

emplois détruits (à 

comparer avec les 

autres site du 

territoire)

Nombre entier

Fonctionnement 

de la synergie

Gouvernance Acteurs impliqués Nombre de groupes 

d’acteurs impl iqués dans 

le projet

T1 Analyse du jeu 

d'acteur

Intérêt 

général/Intérêt 

commun/Intérêt 

privé

nombre de groupes 

d’acteurs impl iqués 

dans le projet

nombre entier

intégration 

environnementale

Indicateurs 

monétarisés

Effet de productivité Evaluation de l'impact 

direct de la perturbation de 

l'écosystème sur le 

processus industriel

Intérêt 

commun/Intérêt 

privé

estimation par expert euros

Réduction des flux 

E/S Eau

Consommation d’eau 

potable

part de l’eau potable sur la 

quantité d’eau totale 

consommée

Intérêt 

général/Intérêt 

commun/Intérêt 

privé

m3 d'eau potable x 

100 / m3 eau totale

pourcentage
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ILLUSTRATION 
 
Dans le même exemple que sur la fiche précédente, le porteur de projet a dégagé 2 actions 
possibles : la collecte mutualisée par le prestataire hors territoire et la collecte mutualisée sur le 
territoire, ce dernier ayant a priori sa préférence. Le porteur de projet sélectionne les indicateurs pour 
lesquels il a des valeurs fiables.  
 
De plus, les indicateurs permettent à la fois de prendre en compte les différents niveaux d’intérêt et de 
mesurer des effets externes : 
 

- la complexité technique (fonctionnement de la synergie), indicateur issu de l’analyse 
technique du module 2 sur une échelle de 0 à 21 ; 

 
- le prix de la prestation (fonctionnement interne) issu de l’analyse économique du module 2 ; 
- la distance  parcourue entre le lieu de collecte et le lieu de traitement des déchets (réduction 

des flux entrant et sortant) ; 
 
- l’activité locale générée (développement territorial) mesurés sur une échelle de 1 (faible) à 5 

(forte) ;  
 
- l’impact environnemental  négatif  et l’impact environnemental  positif (intégration 

environnementale) mesurés sur une échelle de 1 (faible) à 5 (fort) ; 
 
L’évaluation des actions montre que les deux scenarii envisagés apportent des avantages avec 
un minimum d’inconvénients. L’évaluation à priori ne permet pas d’exclure l’une ou l’autre des 
solutions.  
 
Cependant, les avantages et inconvénients sont différents pour chacune d’elles : 
 
- Le traitement hors du territoire valorise les déchets et est peu coûteux mais il ne permet pas 

d’augmenter l’activité locale et oblige à parcourir de grandes distances entre les lieux de 
collecte et de traitement. 

 
- Le traitement sur le territoire valorise les déchets avec une forme de bouclage (déchets 

fermentescibles qui servent à l’agriculture qui, elle-même, alimente l’industrie agroalimentaire) 
et augmente l’activité locale mais avec un coût plus élevé pour les entreprises. 

 
 
L’évaluation à priori ne permet donc pas de départager les scenarii. La méthode d’analyse multicritère 
présentée dans la fiche suivante aidera à poser plus clairement les paramètres de la décision. 
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Classement des scenarios 

Fiche action 18: 
De l’analyse multicritère aux scenarios de mise en œuvre  

OBJECTIFS 
Certaines actions dont la faisabilité l’intérêt sont a priori confirmés appellent néanmoins d’être 
évaluées plus finement ou comparées entre elles afin d’engager ou non ou encore de prioriser leur 
mise en œuvre à plus ou mois long terme. L’analyse multicritère (AMC), comme outil d’aide à la 
décision , permet de le faire en se basant sur des critères et leur importance relative les uns par 
rapport aux autres (pondérations). 

L’AMC aide à opérer un choix entre plusieurs scenarii ou confirmer un choix déjà pressenti. Dans les 
deux cas, l’AMC donne aussi des indications sur les points forts et les points faibles des actions. Elle 
permet également de faire apparaître les points de convergence et de divergence des acteurs de 
façon concrète. Ainsi, l’AMC permet de dégager un ensemble de scenarios parmi lesquels les acteurs 
devront choisir ceux qui consensus.  

Différents logiciels existent pour les AMC. Nous proposons d’utiliser une version d’essai de Decision 
Lab®. Ce logiciel est basé sur la méthode de sur-classement PROMETHEE et la représentation 
graphique GAIA. 

A cette étape, il faut  : 

- Sélectionner des critères d’évaluation des actions ou scenarios 
- Définir leur poids dans l’AMC ; 
- Pour le logiciel Decision Lab®, définir les fonctions de préférence. 

 
Selon des critères définis par les parties prenantes (fiche action 17), le logiciel propose donc un 
classement des actions/scenarios envisagés en fonction de l'importance relative des critères. Ce 
classement n'est pas un classement complet, il permet de prendre en compte l'incomparabilité 
potentielle des actions (actions présentant des choix sur des bases radicalement différentes). De plus, 
il propose d'autres représentations visuelles de ce classement, soit graphiques (plan GAIA), soit plus 
interactives, et peut ainsi être utilisé pour mettre en lumières les arguments décisifs pour ou contre la 
mise en place d'une action/d’un scenario précis.  

METHODE 
La sélection des critères doit respecter quelques règles pour que l’AMC soit pertinente : 

- Les critères doivent être discriminants : valeur différente pour au moins 2 actions  
- il est conseillé de retenir au moins un critère issu de chaque thématique à évaluer (aspects 

économiques, techniques, effets territoriaux…), cf. Fiche action 2. 
- Il faut éviter les redondances qui risquent de surévaluer l’importance d’un critère  
- Il est préférable que le poids relatif de chaque critère soit le fruit d’une discussion entre les 

acteurs. On peut mener plusieurs l’AMC avec des pondérations différentes et comparer  
- La variation des pondérations permet de tester la sensibilité/la robustesse des résultats. 

 
L’utilisation du logiciel Decision Lab® nécessite également de déterminer la forme des fonctions de 
préférences et, selon les fonctions, les seuils de préférence et/ou d’indifférence. On aboutit sur un 
classement des scenarios possibles pour une action. Suite à l’AMC, les acteurs pourront déterminer la 
ou les actions ou les scenarios qui leur semblent les plus adéquats, que ce soit pour l’entreprise ou à 
l’échelle de la démarche territoriale.  

OUTILS 
- Méthodologie d'utilisation de l’analyse multicritère  
- Logiciel Decision Lab® ;  
- Tutorial pour l'utilisation du logiciel. 
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ILLUSTRATION 
Dans l’exemple décliné sur les deux fiches précédentes, il reste au porteur de projet trois actions possibles : la collecte mutualisée des déchets 
fermentescibles avec le traitement hors du territoire (1), le traitement sur le territoire (2) mais aussi le statu quo (3). À priori, sa préférence va à la deuxième 
solution en raison de son potentiel de création d’activité sur le territoire et pour le bouclage d’une partie du flux. 

L’analyse multicritère va lui permettre de comparer les trois actions et de les classer. Pour cela, le porteur de projet reprend les indicateurs vus dans la fiche 
précédente et s’en sert comme critères. Ainsi, il s’assure de la transversalité de l’analyse en ayant des critères issus de chaque thème. De plus, pour chaque 
critère, il y a des valeurs différentes pour au moins deux actions. 

Les critères retenus sont donc :  

- la complexité technique (fonctionnement de la synergie) issue de l’analyse technique du module 2 sur une échelle de 0 à 21 ; 
- le prix de la prestation (fonctionnement interne) issu de l’analyse économique du module 2 ; 
- la distance  parcourue entre le lieu de collecte et le lieu de traitement des déchets (réduction des flux entrant et sortant) ; 
- l’activité locale générée (développement territorial) mesurée sur une échelle de 1 (faible) à 5 (forte) ;  
- les impacts environnementaux  positifs et négatifs  (intégration environnementale) mesurés sur une échelle de 1 (faible) à 5 (fort) ; 

 

Le résultat de l’AMC donne le scenario territorial comme étant le mieux classé. Il convient de prendre le résultat avec précaution puisqu’il est le fruit, entre 
autres, du choix des critères et de leur pondération. Le plan GAIA (non représenté) montre les critères qui vont dans le sens de l’action ou au contraire ceux 
qui s’y oppose. Dans ce cas précis, le résultat de l’AMC permet au porteur de projet de mieux appréhender les points de divergences ou de réticences. Ainsi il 
aura des éléments pour étayer son argumentation auprès des différents acteurs. Par exemple, le coût de la prestation peut être un frein pour les entreprises 
mais en le relativisant avec les autres critères alors l’association peut argumenter en faveur du traitement local qui génère un potentiel d’activité local 
supérieur. 



 Tutorial pour l’analyse multicritère 
 

 

INTRODUCTION 

L'analyse des flux permet de mettre en évidence des potentiels pour le partage des flux de matière et 
d'énergie sur le territoire. Ces partages de flux peuvent être définis par le type d'utilisation du flux 
(types de synergies) et par leurs modalités de mise en œuvre (souvent appelées scenarios dans notre 
méthodologie).  
 
Nous employons le terme d’« actions » pour évoquer ces synergies ou ces scenarios dans l’outil 
d’analyse multicritère que nous utilisons. Les « actions » renvoient ainsi aux différentes possibilités de 
choix pour le(s) décideur(s), qui peuvent être : 
 

- des synergies à comparer  
- des  modalités de mise en œuvre d’une même synergie à comparer (scenarios) 
- des modalités de mise en œuvre de synergies différentes à comparer (scenarios) 

 

OBJECTIFS DE L’ANALYSE MULTICRITERE 

L'analyse multicritère permet de décrire la réalité dans laquelle s'inscrit le problème de décision 
(éléments de contexte) pour mieux la comprendre et la gérer. L'approche mathématique permet de 
construire une représentation quantifiée des éléments déterminants de la décision (objectifs de 
l'action, critères de décision…) et des préférences des décisionnaires. La méthode consiste en une 
optimisation mathématique sous contraintes, ces contraintes pouvant s'exprimer aussi bien de 
manière quantitative que qualitative (rapportée à une échelle). Quand les critères et les préférences 
sont définis au plus proche du problème de décision, alors cette approche permet d'identifier les 
points de convergence et de tension sur les critères de décision des parties prenantes, afin de tendre 
vers le meilleur compromis possible. 
 

DEROULEMENT DE METHODOLOGIE 

Les étapes à suivre  

1. Définition du problème de décision 
2. Définition des critères de décision 
3. Construction d'une structure de préférences 
4. Méthodologie de classement par l’AMC 
5. Approche prescriptive : méthodologie PROMETHEE I et II par classements partiels ou complets 

des actions 
6. Approche descriptive : méthodologie GAIA de mise en perspective des classements 

PROMETHEE 
7. Analyse de sensibilité : “walking-weights” 
8. Commentaires 
 

Définition du problème de décision  

Deux types de problèmes et de décisions sont traités :  

� Le choix  des synergies à mettre en œuvre en priorité dans le cadre de la stratégie d’entreprise ou 
de la démarche territoriale 

 

� La comparaison  des différentes modalités de mise en œuvre d'une synergie particulière (ex : 
utilisation d'un flux d'eau chaude) 



Quatre types de résultats sont proposés : 

� Choix d’un ensemble d’actions : déterminer un sous-ensemble d'actions (les meilleures) parmi 
lesquelles choisir. On ne propose pas une solution ou action préférée 

 

� Tri  des actions dans des catégories prédéterminées (ex : actions satisfaisant un groupe de 
critères prédéfinis) 

  

� Classement  des actions : de celle qui répond le mieux à un ensemble des critères à celles qui y 
répondent le moins bien 

 

� Description  des actions et conséquences  
 

Définition des critères de décision  

Les critères choisis pour la comparaison des actions considérées doivent correspondre à des 
caractéristiques mesurables pour toutes les actions. Les valeurs prises par ces critères (quantitatifs ou 
qualitatifs) doivent permettre un classement ordonné des actions pour chaque critère retenu.  

La construction d'une famille cohérente de critères représentant l'ensemble des objectifs ou aspects 
du problème (action et conséquences) doit à la fois tendre à l'exhaustivité tout en évitant les critères 
liés ou redondants.  

Il faut, en particulier, tendre vers l'indépendance des critères. Néanmoins, des critères 
interdépendants peuvent être conservés lorsqu’ils décrivent des aspects complémentaires de la 
décision.  

Notons que pour les critères à valeurs qualitatives, le choix d’une échelle assez large permet une 
bonne qualité de l'évaluation (plus ou moins 7 niveaux), sans que ce soit une règle de paramétrage du 
logiciel d'aide à la décision.  

Néanmoins, le choix d'un niveau neutre dans la graduation porte toujours le risque que cette valeur 
soit utilisée comme valeur refuge, limitant ainsi la portée de l'analyse.  

Enfin, l'échelle qualitative est ramenée à une échelle numérique sous-jacente.  

 

Modélisation des préférences  

L'analyse multicritère se fait sur une base de comparaison d'actions deux à deux, les seuils de 
préférence et d'indifférence s'appliquent à la différence relative des valeurs prises par le critère dans 
chacun des cas observés.  

Pour pouvoir faire apparaître une structure de préférence, il faut, au préalable, définir ces seuils de 
préférence et d'indifférence ainsi que la forme que prend la fonction de préférence. Cette structure de 
préférence doit être définie pour chacun des critères.  

Un seuil de préférence est la différence de valeur à partir de laquelle une action est préférée de façon 
stricte à une autre pour à un critère précis (toutes choses égales par ailleurs).  

Un seuil d'indifférence est la différence de valeur au-dessous de laquelle une action est indifférente à 
une autre, sa réalisation n'est pas préférée à celle de l'autre action.  

Entre les deux, la préférence est déterminée par la relation mathématique de la fonction de 
préférence.  

Notons que les seuils d'exclusion sont identifiés en amont de l'analyse multicritère et les actions en 
dehors du champ des possibles ne sont pas prises en compte pour l'analyse multicritère.  

 

 



Les critères d'analyse sont représentés selon les formes de fonction de préférence qui les 
caractérisent :  

 

� Critère usuel  (type I du document ci-dessous) qui marque une préférence stricte dès qu'il existe 
une différence d'appréciation entre deux actions, il n'y a alors pas de seuil d'indifférence ni de 
préférence car dès qu'apparait une différence de valeur, la préférence est immédiatement 
marquée. Cette forme est particulièrement utilisée pour les critères à deux niveaux du type 
oui/non. 

 
 
� Critère en U  ou quasi-critère (type II) s'utilise dans les cas où il y a complète indifférence jusqu’à 

ce que la différence soit considérée comme significative. A partir de là, la préférence devient 
stricte pour la meilleure valeur. Le passage de l'indifférence à la préférence stricte est immédiat, 
contrairement au critère linaire. Ce sont des critères avec un effet de seuil. Cette fonction de 
préférence se prête bien aux critères pour lesquels il y a un niveau à ne pas dépasser. Par 
exemple, un produit chimique qui si la quantité dans les effluents dépasse un seuil alors on 
contrevient à la réglementation.  

 
 
� On utilise le Critère en V ou à préférence linéaire  (type III) pour des critères prenant des valeurs 

continues mais pour lesquels il n'y a pas de seuil d'indifférence. La préférence pour une action 
augmente alors linéairement avec l'augmentation de la différence des valeurs prises par le critère 
dans les deux situations comparées. Il s'appliquera plutôt dans des cas où on observe des 
variations relatives et le choix dépendra beaucoup de l'échelle de l'unité utilisée pour le critère.  

 
 
� Critère à palier (type IV) est souvent utilisé pour caractériser des appréciations qualitatives de 

type : « mauvais, moyen et bon ». La méthode PROMETHEE demande des données chiffrées 
pour pouvoir faire les calculs de différences. Ainsi dans l’exemple, on peut faire correspondre 
l’appréciation aux valeurs 1, 2 et 3. En fixant de seuil d’indifférence à 0,5 et le seuil de préférence 
à 1,5 alors un écart de 1 donnerait une préférence faible et un écart de 2 donnerait une 
préférence stricte.    

 
 
� Critère à préférence linéaire avec zone d'indiffére nce  (type V) qui s'applique plutôt aux critères 

quantitatifs prenant des valeurs continues pour lesquels un seuil d’indifférence et un seuil de 
préférence doivent être fixés. C'est le cas, par exemple, de critères reflétant une diminution dans 
la consommation d'une source d'énergie fossile. Le seuil d'indifférence représente le niveau à 
partir duquel une action est préférée à une autre. Cette préférence augmente alors linéairement 
jusqu'à atteindre le seuil de préférence à partir duquel la préférence est stricte pour une action sur 
une autre.  

 
 
� Critère gaussien (type VI), plus rarement utilisé, représente les cas où il n'y a pas de seuils 

d'indifférence et de préférence mais un point d'inflexion dans l'augmentation de la préférence pour 
une action. Dès qu'il y a une différence de valeur, alors la préférence augmente d'abord lentement 
jusqu'à ce qu'on atteigne un point d'inflexion à partir duquel la préférence augmente de manière 
plus exponentielle. Cette fonction n'est utilisée qu'en de rare cas que nous ne discuterons pas ici.   



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Source : Brans et Mareschal (2002) 
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Critère usuel (Type I) _

Critère en U ou quasi-critère

(Type II) 

qj : seuil 

d'indifférence

Critère en V ou à préférence

linéaire (Type III)

pj : seuil de 

préférence 

stricte

Critère à palier (Type IV)

qj : seuil 

d'indifférence

pj : seuil de 

préférence 

stricte

Critère à préférence linéaire

avec zone d'indifférence

(Type V)

qj : seuil 

d'indifférence

pj : seuil de 

préférence 

stricte

Critère gaussien (Type VI)
Sj : seuil de 

préférence

Forme graphique



figure 1. Copie d’écran du logiciel DecisionLab ®. Tableau vierge 

 

 

Pondération des critères 

La pondération des critères est un élément important de l’AMC. Concrètement, elle reflète 
l’importance relative donnée à chacun des critères de décision. Le choix de pondération est celui de 
l'utilisateur (ou organisme qu'il représente) et est fonction d’un ensemble d’éléments liés à la synergie 
elle-même mais aussi au contexte. Ainsi, si la sélection des critères est en partie déterminée par des 
éléments extérieurs (cf. supra), leur pondération n’est soumise qu’à la décision de l’utilisateur (au nom 
d'un acteur ou un groupe d'acteurs). 

Cet aspect est fondamental car déterminant pour les résultats de l'analyse. Comme nous le traitons 
plus loin, les variations relatives des pondérations peuvent faire basculer le classement. Ceci relativise 
la portée des résultats comme solution au problème de décision et les repositionne plutôt comme 
éléments dans la réflexion et la discussion entre parties prenantes. Nous nous situons dans le cadre 
d'un outil d’aide à la décision. 

Nous proposons deux façons de déterminer les pondérations. La première consiste à faire se 
rencontrer les parties prenantes pour qu’elles discutent des critères et de l’importance de chacun 
d’eux par rapport aux autres (pondération). La seconde consiste à laisser le porteur de 
projet/utilisateur déterminer les pondérations en fonction de ses connaissances des acteurs, de leurs 
intérêts et des enjeux de la synergie. 

Le logiciel permet aussi de multiplier les points de vue et propose une fonctionnalité multi-acteurs. En 
gardant les mêmes critères pour chacune des visions sur la synergie, il est possible de faire varier les 
pondérations (les valeurs et le système de préférence) pour chacun des critères. Ainsi, il est possible 
de comparer les résultats de l’AMC en fonction des parties prenantes (ou groupes de parties 
prenantes) et donc de confronter les points de vue pour mieux comprendre les points de convergence 
et de divergence (voire d'opposition). L'étude de ces comparaisons est au cœur de l'analyse plus 
descriptive que prescriptive de l'analyse multicritère.  

 



 Remarque 

On observe l'amplitude des écarts des valeurs prises par le critère analysé pour chacune des actions. 
Il faut donc être attentif aux effets d'échelle d'un critère à l'autre, la variation d'une unité d'un critère 
n'est pas nécessairement équivalente à la variation d'une unité de l'autre. Il faut, autant que possible, 
rester relativement simple et bien comprendre la méthodologie pour pouvoir analyser les résultats en 
toute confiance. Il est également préférable de limiter l'utilisation de paramètres trop techniques car 
l'analyse a besoin d'un sens fort en termes de réalité et de spécificités du territoire.  

 

Méthodologie du classement  

L’aide à la décision par l’analyse multicritère se base sur la comparaison deux à deux des valeurs 
prises par un critère selon les actions. La méthodologie ramène ces différences à une échelle 
commune de valeurs, c'est ce qu'on appelle le degré de préférence et il est noté de 0 à 1, 1 étant la 
préférence stricte.  

La moyenne des préférences pour chaque critère permet de classer les deux actions comparées l’une 
par rapport à l’autre. Mais il ne s’agit pas de comparer que deux actions.  

La méthodologie permet d’effectuer un classement entre l’ensemble des actions basé sur cette 
comparaison deux à deux selon deux axes : 

� la domination d’une action donnée sur les autres  
 

� la domination de chaque action sur cette même action donnée. 
 

Une action est préférée aux autres à partir du moment où elle domine les autres et qu’elle est la moins 
dominé par les autres. Il n’en reste pas moins qu’une action peut être efficace pour un critère ou un 
groupe de critères uniquement. L’analyse multicritère ne se réduit pas à un classement d’actions mais 
au contraire permet aussi une analyse plus fine dans la comparaison des actions. 

 

figure 2. Commandes de visualisation des classement s et plan GAIA 

 
 



figure 3. Commande de visualisation des walking-wei ghts 

 
 

PROMETHE : classement partiel et complet  

La méthodologie PROMETHEE propose de calculer un degré de préférence d'une action sur l'autre, 
c'est-à-dire la différence mathématique ramenée à l'échelle des valeurs prises par le critère dans 
chacune des actions comparées. Cette préférence est ramenée à une note entre 0 et 1, plus elle est 
élevée, plus l'action est préférée, 1 traduisant une préférence stricte.  

Un tableau croisé des comparaisons deux à deux permet de faire des sommes en ligne et en colonne 
de ces degrés de préférence pour faire ressortir le degré moyen de préférence (somme pondérée des 
degrés de préférence divisée par le nombre d'action, Φ+) d'une action sur les autres, soit une 
moyenne des degrés de domination d'une action sur les autres.  

Parallèlement, on somme en colonne pour mesurer un degré moyen de préférence pour les autres 
actions, Φ- soit la moyenne pondérée des degrés de domination subis par une action par rapport à 
toutes les autres.  

À partir de ces deux mesures, on peut définir deux classements avec classement des actions par 
valeur décroissantes du Φ+ et un autre classement par valeurs croissante du Φ-. On obtient ainsi 
deux classements qui sont souvent différents et rendent les actions incomparables à partir de ces 
deux indicateurs.  



Pour dépasser ce problème de classement, on défini un Φ total = Φ+ - Φ-. Ce Φ permet de proposer 
un seul classement mais un classement dans lequel beaucoup des subtilités de l'analyse sont 
perdues et les conflits entre critères sont compensés. On cherche alors à classer les actions par 
valeurs décroissantes du Φ ce qui permet un classement complet des actions et d'appuyer l'aspect 
prescriptif de la méthodologie PROMETHEE.  

Ainsi, l'analyse peut s'arrêter et le résultat propose de mettre en œuvre l’action préférée, en moyenne. 
L'utilisation d'une moyenne permet de compenser complètement un critère bas (faible degré de 
préférence) par un critère haut (fort degré de préférence), l'action préférée peut parfois être largement 
préférée pour un critère mais totalement dominée par un autre.  

Par exemple, dans le cadre de la méthodologie proposée par COMETHE, un problème peut être la 
compensation d'externalités territoriales très négatives par un gain financier important mais qui ne 
compensera pas réellement le coût environnemental de long terme. 

 

figure 4. Classements PROMETHEE partiel et complet (cas d'incomparabilité 
entre trois scenarii dans le cas du classement part iel)   

 
Dans l'exemple ci-dessus, la moitié gauche du schéma présente le classement partiel tel que proposé 
par la méthodologie PROMETHEE I. Les trois actions comparées se trouvent sur une même colonne 
et ne sont pas reliés entre elles. On dit alors qu'elles sont incomparables, c'est-à-dire que les 
classements selon le Φ+ (somme pondérée des degrés de préférence divisée par le nombre d'action) 
et le 

Φ
- (degré moyen de préférence pour les autres actions) donnent des résultats (classement des 

actions selon chacun des Φ) incompatibles.  

La partie droite présente le classement complet qui résulte de la comparaison des Φ totaux (degré 
moyen de préférence qui est la différence entre Φ+ et Φ-). Ainsi, si on autorise la compensation entre 
la domination d'une action par les autres et domination d'une action sur les autres, alors, il n'y a plus 
d'incomparabilité.  

Néanmoins, l'incomparabilité illustrée par le classement partiel permet de nuancer le résultat du 
classement complet. En effet, s'il est possible de présenter un classement des différentes actions, il 
n'en reste pas moins que la satisfaction de certains critères peut se faire au détriment d'autres critères 
de décision. Par conséquent, une analyse plus poussée est nécessaire pour comprendre les enjeux 
du choix d'action. Comme nous le verrons dans la section suivante, le plan GAIA propose justement 
d'analyser les actions et les critères dans leurs relations les uns aux autres.  



GAIA et analyse descriptive  

Description du plan GAIA 
Le plan GAIA permet une approche plus descriptive du problème de décision. Il propose une 
représentation graphique à k dimensions (k étant le nombre de critères de décision retenus). Pour 
permettre l'analyse, cette représentation est projetée sur un plan à deux dimensions qui permet de 
mettre en évidence les conflits entre critères, d'identifier les compromis possibles et aider à fixer les 
priorités.  

Sur ce plan, les actions sont représentées par des points et les critères par des vecteurs. Ces 
vecteurs indiquent la direction dans laquelle se trouvent les actions y répondant le mieux. La longueur 
des vecteurs traduit la perte d'information pour ce critère due à la projection. Le delta (∆) indique la 
quantité d'information conservée lors de la projection sur le plan GAIA. 

Enfin, le vecteur pi représente le vecteur de décision qui reprend l'ensemble des critères et leurs 
pondérations. Le delta ne permet pas de mesurer la perte d'information dans la représentation de l'axe 
de décision. Plus le vecteur est long, plus l'interprétation est aisée.  

 

Méthode d'analyse  

Plan GAIA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



La proximité graphique des points et vecteurs représente une proximité analytique (actions proches et 
critère allant dans le même sens). Les critères représentés par des vecteurs opposés correspondent à 
des critères divergents et qui entrent en conflit dans le processus de décision. Les critères opposés 
nécessitent un arbitrage sur les critères ou groupes de critères.  

Le principe général d'analyse se base sur une observation des regroupements/dispersions de points 
(actions) et des vecteurs (direction et sens). On identifie par première observation les actions qui 
satisfont de manière similaire les critères et celles qui proposent des compromis très différents.  

De même, l'observation des vecteurs permet d'identifier les critères qui font pencher la décision de 
manière complètement opposée (l'augmentation de la satisfaction d'un critère entraîne que l'autre 
critère l'est moins).  

 

La méthode GAIA consiste à considérer les critères comme autant de vecteurs de différentes 
dimensions. Dans cette expérience, il y a sept critères (complexité technique, contrainte 
réglementaire, économie d’énergie, attractivité, consommation de gaz, gouvernance, coût en capital) 
donc sept vecteurs dans sept dimensions différentes.  

Comme il est impossible de représenter autant de dimensions, les vecteurs sont projetés sur un 
même plan. Cependant, cette projection s’accompagne d’une perte d’information et le pourcentage 
d'information conservée est indiqué en bas à gauche de la fenêtre du plan GAIA. Ici, le delta est de 
100%, il n’y a donc pas de perte d’information et la lecture du plan est fiable. 

Le plan GAIA confirme les résultats de classement PROMETHEE mais il apporte également des 
informations complémentaires intéressantes. D’abord, le positionnement des synergies par rapport 
aux axes des critères informe sur ceux qui font pencher la balance en faveur d'une action ou d'une 
autre action.  

La complexité technique et la contrainte réglementaire (et dans une moindre mesure, le coût en 
capital) font préférer au décideur la solution du statu quo, comme le montrent les directions des axes 
portant les vecteurs, représentation des critères de décision.  

Par contre, le critère économie d’énergie va à son encontre. Les critères de coût et d’économie 
d’énergie vont dans le sens de la synergie “interne.” On peut remarquer en revanche que le coût est 
en totale opposition avec les critères “attractivité” et “consommation de gaz”, comme l'illustre le fait 
que son vecteur va dans la direction opposée à celles des deux autres. Cela nous permet de 
visualiser vraiment en quoi la synergie "interne" n’est pas la préférée. Enfin, La synergie “territoire” est 
favorisée par ces deux derniers critères cités.  

 

En conclusion, même si le classement partiel proposé par PROMETHEE I ne conclut pas en termes 
d'action d'EI préférée par les parties prenantes, l'analyse de plan GAIA permet d'identifier les critères 
convergents, divergents voire même contradictoire entre eux ou pour une action. Ainsi, selon 
l'importance donnée aux critères par les différentes parties prenantes, l'analyse du plan GAIA permet 
d'identifier les critères de décision sur lesquels les parties prenantes devront négocier et trouver un 
compromis.  

 

Analyse de sensibilité : les walking-weights  

La méthodologie des walking-weights permet de faire varier les pondérations accordées à chaque 
critère pour pouvoir observer les variations induites. Pour PROMETHEE, les variations à observer 
sont celles du classement des actions et des Φ. En ce qui concerne le plan GAIA, l'observation se 
portera plutôt sur les variations de l'axe de décision et sa comparaison aux autres vecteurs de 
critères.  



Il est alors intéressant d'identifier et d'interpréter les points d'inflexion, c'est-à-dire à partir de quel 
moment le classement change, ou Φ devient positif, ou encore à partir du moment où une action 
commence à en dominer une autre. Il est parfois intéressant de définir des groupes de critères dont 
les pondérations sont fixées. Il y a alors moins de critères à observer et les variations du pi peuvent 
alors devenir importantes.  

Note : les illustrations proposées ici correspondront au cas d'étude présenté dans le rapport 
scientifique et concernent une synergie eau et une synergie chaleur sur le territoire de l'Aube.  

figure 5. Exemple de walking-weights : modification  du classement dans le 
graphique en fonction du poids du "coût en capital"  (cadran bas) 

 

Remarques finales   

L'analyse multicritère pour l'aide à la décision est un outil qu'il convient de manier avec précaution. 
Comme le montre cette notice d'utilisation, les axes d'analyse potentiels sont multiples et sont à 
mobiliser de manière interactive. Au-delà d'indiquer une solution préférable du point de vue des 
critères de décision des parties prenantes, l'analyse multicritère permet de revisiter le problème de 
décision à la lumière d'une analyse prenant en compte les relations entre critères (convergence, 
divergence, incompatibilité…).  

L'outil propose un certain nombre de fonctionnalités qu'il est alors intéressant de tester pour envisager 
d'autres pistes d'analyse du problème de décision étudié. Ainsi, nous avons listé quatre points que 
l'utilisateur pourra trouver en complément de la méthodologie d'analyse proposée ci-dessus.  

� Indépendance des critères  : sur le plan GAIA, plus les critères sont proches, plus il existe une 
corrélation. Cette corrélation peut révéler un lien entre les critères voire une redondance qui 
amènerait une surestimation de cet élément. Néanmoins, des critères proches peuvent apporter 
des informations complémentaires et intéressantes pour l'interprétation. Dans ce cas, il peut être 
préjudiciable d'en éliminer un au bénéfice de l'autre, l'analyse serait alors moins riche.  

 

� Agrégation des dimensions  : regroupement des critères en famille ou catégories avec 
pondération relatives fixes. Il n'y a alors plus qu'un seul axe pour représenter ce groupe. Cette 
approche est utile quand il y a beaucoup de critères de décision, on crée alors un critère 
synthétique qui est une somme pondérée des différents critères le composant. Ce critère 
synthétique peut aussi être analysé par le biais des walking-weighs.  

 

� Accorder un temps de réflexion sur les critères inavoués .  
 
 

� Il existe une version du logiciel DecisionLab® en mode multi-acteurs  permettant de modéliser les 
préférences de différents groupes d'acteurs sur les mêmes critères puis de comparer les 
classements et représentations graphiques.  



Module 3 – Définir les scenarios de mise en œuvre des actions 

 

Fiche action 19:  
Cartographie des scenarios d’actions envisagés 

OBJECTIFS  

Il s’agit d’utiliser un logiciel de cartographie pour géo-référencer les données recueillies lors de 
l'analyse des flux de matière et d'énergie et retenues dans le cadre de l’analyse multicritères sur les 
synergies potentielles.  

Cet exercice de cartographie a pour but d’alimenter les discussions entre les différentes parties 
prenantes du territoire (collectivité, gestionnaire de zones d’activités, entreprises, etc.), en facilitant la 
lecture et la visualisation des synergies potentielles (contraintes géographiques, environnement des 
synergies, etc.).  

Il complète ainsi le panel d’outils de diagnostics et d’aide à la décision utilisés par l’équipe-projet pour 
l’animation des discussions entre les parties prenantes du territoire.  

Ce prototype d’outil utilise les données extraites (au format Excel) des bases de données collectées et 
d’analyse du logiciel Presteo® ainsi que le logiciel de traitement cartographique Manifold®. 

METHODE 

Afin d’éviter des représentations cartographiées de synergies trop complexes et/ou non consolidées, 
le prototype d’outil SIG développé se base sur les données de flux issues des autres travaux du projet 
COMETHE, compilées par l’outil Presteo® et sur les préconisations issus de l’outil d’analyse 
multicritère.  

Ce filtre d’analyse préalable nécessite néanmoins en amont et/ou en parallèle une expertise humaine 
complémentaire afin de cartographier les synergies potentielles les plus intéressantes, en lançant par 
exemple les requêtes spatiales les plus pertinentes.  

De la même manière, le choix des supports cartographiques permet d’alimenter les options de 
visualisation, en faisant apparaître des éléments plus ou moins clés la décision (positionnement des 
acteurs, des collectivités, des réseaux de transport, contraintes géographiques, codes couleurs, etc.).  

OUTILS 

- Prototype d’outil SIG COMETHE – application pour l’écologie industrielle 

- Tutorial pour l'utilisation du logiciel SIG Manifol d®, en interaction avec le logiciel 
Presteo® développé par la société Systèmes Durables (membre du consortium COMETHE) 

ILLUSTRATION 

Cartographie de projets d’entreprises et de territoire étudiés sur le territoire dunkerquois dans le cadre 
du projet COMETHE (page suivante). 
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Synergies interentreprises potentielles 

 

Le cas des fermentescibles : inventaire des flux de  déchets  

 

Scenario de valorisation locale des fermentescibles  (méthaniseur de Calais)  
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 Tutorial pour l’utilisation du SIG 

RESUME 
L’utilisation d’un Système d’Informations Géographiques (SIG) dans un projet d’écologie industrielle 
permet de cartographier le territoire, les acteurs de la démarche, les flux et les synergies potentielles.  

Un prototype d’outil SIG a été développé dans le cadre de COMETHE en complémentarité avec l’outil 
de compilation et d’analyse de données de flux de matière et d’énergie Presteo®, qui permet 
d’identifier des pistes de synergies interentreprises à partir de ces données. On peut transférer, via les 
imports Excel, les données issues des collectes Presteo® au sein du logiciel S.I.G. Manifold® et de les 
visualiser sur un support cartographique. 

Ce document vise donc à la fois à présenter le prot otype d’outil de visualisation des synergies 
développées dans le cadre de COMETHE et d’en explic iter les étapes d’utilisation. Il s’articule 
en trois temps : 

- Présentation, expérimentation et perspectives du prototype d’outil de visualisation des synergies 
- Tutorial du prototype d’outil de visualisation des synergies 
- Quelques clés supplémentaires pour l’utilisation de Manifold® 
 

Remarque : l’outil SIG développé dans le cadre du projet COMETHE s’est base sur un tableur 
d’extraction de données issues de Presteo© (logiciel de recherche de synergies développé par la 
société Systèmes Durables, membres du consortium COMETHE, et utilisé par les territoires 
d’expérimentation du projet). Néanmoins, cet outil SIG peut utiliser toute autre forme de tableur 
d’extraction de données. 
 

PRESENTATION, EXPERIMENTATION ET PERSPECTIVES DU 
PROTOTYPE D’OUTIL DE VISUALISATION DES SYNERGIES 
 
Ce chapitre synthétise la démarche pour effectuer une étude d’écologie industrielle et de validation de 
synergies à l’aide d’un logiciel S.I.G. en complémentarité avec Presteo©. Il explicite le processus à 
travers les phases essentielles de la cartographie : la collecte des données, l’utilisation de l’outil, le 
diagnostic, l’aide à la décision et la communication.  
 

 
 
La complémentarité avec Presteo© permet de récupérer intégralement les données attributaires 
saisies pour chaque entreprise, à savoir les informations administratives, les bilans matières et les 
éventuelles synergies.  
 
La localisation de ces informations est possible grâce à la présence des coordonnées XY sous forme 
tabulaire au sein de la base Presteo©. Elles nous permettent de projeter ces informations tabulaires 
sur une carte. Cette carte sera ainsi composée des informations Presteo© choisies et d’un fond de 
carte qui pourra être soit importé d’un SIG territorial soit sous forme de fond de plan image 
comparable à Google Maps par exemple. 

Périmètre d’intervention de l’outil 

L’utilisation du logiciel S.I.G. ne remplacera pas l’analyse de données de Presteo et ne permettra 
pas de peaufiner les résultats de ce dernier. Les S.I.G. permettront de juger de la faisabilité et de 
l’impact de la réalisation de synergies. Cette étude sera optimisée par l’expertise humaine qui, à 
l’aide de Manifold, sera en mesure d’apprécier et de prendre en compte les différents paramètres 
territoriaux essentiels pour la mise en place de synergies. 



Module 3 – Définir les scenarios de mise en œuvre 

 

 2 

 
Le rôle du prototype proposé est de guider les utilisateurs à travers ces étapes de visualisation des 
bilans matières et des synergies en automatisant les tâches les plus compliquées. Le résultat obtenu 
est une couche d’information spécifique, bilan matière ou synergie, qui pourra ensuite être 
personnalisée et superposée à d’autres informations géolocalisées. Ces couches pourront également 
être utilisées dans des processus d’analyse SIG avancés tel que des analyses de réseau de transport, 
d’estimation des coûts, des risques ou des émissions de gaz à effet de serre par exemple. 
 
Voici de façon schématique la succession des tâches  effectuées par le prototype d’outil de 
visualisation des synergies : 

 

 

PRESTEO 

Export tabulaire des 

résultats de requête 

Bilan Matière 

 

Bilan matière à 

cartographier 

Importation des tables 

dans Manifold 

 

Manifold 

Prototype SIG 

Assistant cartographie 

 Bilan Matière 

Export tabulaire de la 

couche entreprise 

 

Export tabulaire des 

résultats de requête 

Synergies 

 

Cartographie des 

Bilan Matière 

Synergies à 

cartographier 
Table des entreprises 

Assistant cartographie 

 Synergies 

 

Cartographie des 

Synergies 
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Collecte de données 
La collecte de données a été réalisée au sein de Presteo©. Il ne reste donc qu’à sélectionner les 
données à exporter à l’aide de requêtes sur la base Presteo© puis d’exporter le résultat de la requête 
dans un format tabulaire (xls, csv…). 
 
Les informations à exporter concerne 3 tables Presteo© en particulier :  

- Ref_entreprise 
- Ref_flux ou Ref_composant 
- Ref_ssynergie_flux ou Ref_ssynergie_comp 
-  

Voici un exemple pour chacune de ces tables des attributs régulièrement disponible : 
 
Table Entreprise 
nom_entreprise Nom de l’entreprise Integer 
siret  Code SIRET de l’entreprise  String 
adresse Adresse de l’entreprise String 
contact Contact EI au sein de l’entreprise String 
code_naf Code NAF pour la chaîne trophique String 
x Coordonnée x (Lambert Etendu) Integer 
y Coordonnée y (Lambert Etendu) Integer 
 
 
Table Matière 1 
Id_user Identifiant de l’utilisateur Integer 
Id_ent Identifiant de l’entreprise Integer 
nom_ent Nom de l’entreprise String 
nom_composant Nom du matériau  String 
taux Taux du composant dans le process Integer 
quantite Quantité du composant String 
sens Définis si le flux est entrant ou sortant String 
énergie, pression, 
température…  

Informations complémentaires String 

x Coordonnée x (Lambert Etendu) Integer 
y Coordonnée y (Lambert Etendu) Integer 
 
 
Table Synergie 1 
Id_user Identifiant de l’utilisateur Integer 
Id_ent Identifiant de l’entreprise Integer 

nom_ent_e Nom de l’entreprise destination String 
nom_ent_s Nom de l’entreprise origine String 
designation_flux_e Désignation du flux entrant String 
designation_flux_s Désignation du flux sortant String 
quant_e Quantité demandé par ent_e Integer 
quant_s Quantité offerte par ent_s Integer 
distance Distance entre les 2 entreprises Integer 
x Coordonnée x (Lambert Etendu) Integer 
y Coordonnée y (Lambert Etendu) Integer 
 
Les liens se feront facilement entre ces tables à l’aide d’attributs communs dont la cohérence est 
gérée par Presteo©, à savoir, nom_ent ou  id_ent par exemple. 
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Utilisation du prototype de visualisation des syner gies 
 
Création d’une interface pour une mise en capacité des territoires  
 
Dans l’optique d’une mise en capacité et d’une autonomie des territoires porteurs de démarche 
d’écologie industrielle, le développement du prototype d’outil a également mis l’accent sur la création 
d’une interface et de script automatisant la visualisation des synergies retenues.  
 
 
A l’ouverture de l’outil, vous trouverez l’interface suivante :  

 

Mise en relation avec l’analyse multicritère (modul e 3) 

La collecte de données concernant les synergies intègre les informations technico-économiques, 
réglementaires et environnementales. Ces données auront permis de discriminer dans un premier 
les temps les synergies les plus plausibles avant d’être intégrées au S.I.G. Après renseignement, 
la visualisation de ces données sera simplifiée et claire car associées à la cartographie des 
synergies.  

Piste d’évolution du prototype : Complément de donn ées 

A terme il sera intéressant de compléter les paramètres d’étude en intégrant de nouvelles données 
comme les risques technologiques, les risques environnementaux ou encore des données de type 
socio-économique comme la répartition des pôles de compétitivité ou les informations relatives à 
l’emploi. Une approche des acteurs détenant ces informations devra être menée comme l’INSEE 
ou encore la DREAL… 
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Les principaux éléments spécifique au projet COMETH E sont : 

- La barre d’outil permettant de lancer les 3 fonctions principales de l’outil : 

o  : Configuration générale de l’outil 

o  : Assistant cartographie des bilans matière 

o  : Assistant cartographie des synergies 
- La fenétre projet permettant de gérer les différentes données du projet : 

o _Cartes : Dossier dans lequel seront sauvées les différentes cartes au cours du projet 
o _Fonds de plan : Dossier stockant les fonds de cartes interactifs à disposition 
o _Systeme : Ne pas toucher !  
o Import : Contiendra vos nouvelles données importées 
o Vous pouvez créer des dossiers facilement afin d’y stocker des fonds cartographiques 

propres à votre territoire, utilisables ensuite pour les cartes à la place des fonds de 
cartes globaux. 

Nous allons voir plus en détail ces fonctions par la suite. 

 
La description et la documentation de ce prototype se trouve en seconde partie de ce document 
« Tutorial du prototype d’outil de visualisation des synergies ». 
 

 
Expérimentation du prototype sur la zone industriel le du Dunkerquois – Exemple du flux acide 

 

 
FIGURE 1 - VISUALISATION DES FLUX ACIDES SORTANTS 
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FIGURE 2 - VISUALISATION DES FLUX ACIDES ENTRANTS 

 
 
 

 
FIGURE 3 - VISUALISATION DES SYNERGIES ACIDES POTENTIELLES 
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Expérimentation du prototype sur le territoire aubo is  

 

FIGURE 4 -  GEO-LOCALISATION DE GISEMENTS PERTINENTS ET DE PERIMETRES DE COLLECTE POUR L’ALIMENTATION D’UNE CHAUDIERE 

BOIS LOCALE  - SOURCE AUXILIA, 2009 
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Diagnostic et aide à la décision, pistes de dévelop pement de l’outil de 
visualisation des synergies 

 
La phase de diagnostic au sein de la démarche S.I.G. en écologie industrielle est une étape majeure. 
Complémentaire à l’expertise humaine, elle permet de mettre en évidence les synergies potentielles 
les plus aptes à être concrétisées. Le prototype, tel qu’il existe aujourd’hui, permet d’ores et déjà de 
mettre en évidence les acteurs concernés par les synergies retenues, leur positionnement 
géographique (distance) ainsi que les éventuelles contraintes à l’acheminement des flux à échanger 
ou à mutualiser (contraintes topographiques, éloignement des acteurs concernés, absence 
d’infrastructures d’acheminement, absence de foncier disponible pour le stockage, etc.).  
 
Pour compléter cette première analyse, des pistes de développement de ce prototype se dessinent 
d’ores et déjà. Des modules d’aide à la décision pourront être réalisés tout d’abord d’un point de vue 
de la correspondance et de la praticabilité des réseaux de communications, puis des effets 
environnementaux du transport en termes d’émissions de GES1.  
 
Remarque  : ces pistes de développement seront susceptibles d’alimenter le cahier des charges 
fonctionnel pour la mise en œuvre d’une démarche d’écologie industrielle sur une zone d’activités à 
l’issue du projet COMETHE. 
 
 
Praticabilité du réseau  
 
Cette table, associée à chaque matière, pourra déterminer les moyens de communication 
envisageables pour leurs transports. Elle renseignera également la dangerosité de la matière, 
information qui sera discriminante selon les autorisations de transport de telles matières sur certains 
tronçons.  
La capitalisation de données permettra au fur et à mesure d’obtenir un catalogue de matières et de 
leurs caractéristiques. A terme il ne sera plus nécessaire d’entrer toutes les données matières après 
avoir réalisé un certain nombre d’études et d’expérimentations. 
 
Table Matière 
Nom_Matière Nom de la matière String 
Dangerosité Matière étant classée comme dangereuse Boolean 

Route Qualifie si transportable par la route Boolean 
Fer Qualifie si transportable par le fer Boolean 
Navigable Qualifie si transportable par voie navigable Boolean 
Pipe Qualifie si transportable par pipe Boolean 
 
 
Spécificité des réseaux  
 
Ces données indiqueront les axes « fréquentables » par les matières étudiées. Des trajets types 
apparaissent donc et peuvent valider ou décliner la faisabilité d’une synergie. 
 
Table Réseau routier 
Vitesse Limitation de vitesse Integer 
Gabarit Limite de charge sur le tronçon Integer 

Matière_dangereuse Accès autorisé aux matières dangereuses 
(exemple) 

Boolean (O/N)  

Matière_corrosive Accès autorisé aux matières corrosives (exemple)  Boolean (O/N)  
Ouverture hivernale  Boolean (O/N)  

                                                                 

1
 Gaz à Effet de Serre 
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Table Réseau ferré 
Vitesse Limitation de vitesse Integer 
Gabarit Limite de charge sur le tronçon Integer 

Matière_dangereuse Accès autorisé aux matières dangereuses 
(exemple) 

Boolean (O/N)  

Matière_corrosive Accès autorisé aux matières corrosives (exemple)  Boolean (O/N)  
 
Table Réseau fluvial 
Temps de chargement Durée du chargement Integer 
Matière_dangereuse Accès autorisé aux matières dangereuses 

(exemple) 
Boolean (O/N)  

Matière_corrosive Accès autorisé aux matières corrosives (exemple) Boolean (O/N)  
 
Table Réseau pipe 
Matière Matière circulant dans le pipe String 
Diamètre Diamètre du pipe Décimale 
Propriétaire Propriétaire du tronçon String 
 
 

 
 
 
Bilan carbone des transports de flux  

 
Lors de cette étape, une simulation des émissions de CO2 liées aux transports pourra également être 
mise à jour. Elle permettra, dans les cas où plusieurs modes de transports sont disponibles, de 
sélectionner le moins impactant sur l’environnement. Cette observation pourra, à terme, être réalisée 
à l’échelle internationale si des entreprises se fournissent soit au niveau français, européen ou 
mondial. 
 
Cette démarche entrera dans une approche globale de réflexion sur la faisabilité et des impacts 
induits par la mise en place de synergies en écologie industrielle. Outre l’aspect « analyse », cette 
démarche permettra de visualiser les effets des échanges voir même de rationaliser ces derniers en 
favorisant, dans certains cas, des échanges locaux et non plus de longues distances en observant les 
différences notables d’émissions selon le mode de transport sélectionné. 
 
 
Table Carbone 
Type de transport Mode de transport Liste (Route, fer, 

navigable, pipe) 
Facteur d’émissions CO 2  Facteur d’émission en fonction du mode 

de transport (en kg équ. CO2.tonnes.km) 
Décimale 

 
 
 

Limites : classification des axes de communication 

Certaines données (gabarit, autorisation de transport de matières) ne pourront être informées que 
si elles sont renseignées par la structure qui fournira les données. Dans le cas contraire, il sera 
laborieux de recenser ces attributs à chaque tronçon de communication. 
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TUTORIAL DU PROTOTYPE D’OUTIL DE VISUALISATION DES 
SYNERGIES 

I - Importation des données 

I.A. Fond de plan vectoriel 

I.A.1. Import  

File>Import>Drawing>Sélectionner le fichier>Ouvrir 

Sélectionner le format de vos données, le plus souvent Shape (ESRI) ou MIF/MID (MapInfo)  

Import …file>OK 

La donnée est importée et stockée dans le dossier actif de la partie Projet de Manifold : 

 

 

I.A.2. Création d’une carte composée  

Vous pouvez alors superposer vos différentes données afin de recomposer une carte thématique de 
votre territoire. 

Pour cela vous devez créer une nouvelle carte et 
sélectionner les éléments à intégrer :  

- Cliquez sur l’étoile jaune de la zone projet qui 
permet de créer de nouveaux composants et 
choisissez « Map… »: 

- Donnez un nom et sélectionnez les couches à 
superposées.  
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Vous pouvez double cliquer sur la carte créée afin de la visualiser et la modifier. 

 

I.A.3. Edition de la représentation :  

EDITION SIMPLE 

 

Il est en effet important de modifier le style de chaque couche afin d’obtenir la carte souhaitée. Cette 
fonction est gérée par les boutons surligné en haut de l’illustration ci-dessus, agissant sur la couche 
activé par les onglets en bas de la fenêtre. 

Activez la couche à éditer en activant l’onglet :   

  
Et éditez ensuite la couleur du fond, du contour, la taille et le style des 
traits, des points… 

 

Note :  

Vous pouvez modifier la 

superposition des couches 

en faisant glisser un onglet 

vers la droite pour remonter 

la couche ou vers la gauche 

pour la descendre 
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EDITION THEMATIQUE 
Il est possible de représenter les données différemment en fonction d’un attribut.  

Par exemple ici nous pouvons différencier le bâti par l’attribut « Type ». Nous verrons que nous 
pouvons également utiliser cette fonction pour différencier les matières entrantes et sortantes et 
dimensionner le symbole en fonction de la quantité par exemple. 

1- Sélectionnez la couche à éditer comme pour une édition simple 
2- Cliquez sur l’élément à modifier puis choisissez « Thème » :  

a. Sous Field, choisissez l’attribut à utiliser (ici « Type ») 
b. Choisissez la méthode dans le cas de données numériques 
c. Vous pouvez choisir une palette prédéfinie 

Sélectionnez la palette et faites Apply avec la petite flèche 
Ou définissez la couleur manuellement. 

d. OK  
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I.A.4. Affichage des informations attributaires  

Dans un SIG, chaque donnée vectorielle est liée à une donnée tabulaire. Pour afficher depuis le 
dessin les informations liées à l’objet, il suffit de double cliquer dessus. Une fenêtre s’ouvre, éditable 
affichant les données de l’objet : 
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I.B. Données tabulaires Presteo©  
I.B.1. Import des couches « Bilan Matières et Entre prises »  

Ces données ont la caractéristique d’être sous forme de tableur avec des colonnes X et Y qui vont 
nous permettre de géolocaliser l’information. 

Pour cela nous devons transformer le tableau en une couche cartographique.   

Afin de conserver une certaine organisation du projet, sélectionnez le dossier « Import » afin que les 
données importées se stockent directement, puis : 

File>Link>Drawing> 

Cliquez sur l’étoile et sélectionnez votre table. 

  

 

 

 

 

 

 

 

 

Choisissez les colonnes (attributs) à importer et assurez 
vous que le X et le Y seront lu depuis la bonne colonne. 

 

Une série de couches vient s’ajouter au dossier « Import ». Vous pouvez les renommer en faisant un 
clic droit sur l’item principal puis « Rename ». Cochez la case « Adjust names of independant 
composents » afin de renommer tous les composants liés. Seule le composant  [* Drawing]  nous 
intéresse. 

 

 

Vous pouvez voir un message d’alerte sur la projection de ce nouveau composant. Ceci sera réglé par 
l’assistant lors de la création de la carte bilan matière. 
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I.B.2. Import des couches « Synergies »  

 

Afin de conserver une certaines organisations du projet, sélectionnez le dossier « Import » afin que les 
données importées se stockent directement, puis : 

File>Import>Table>Sélectionner le fichier>Ouvrir 

Choisissez le format puis sélectionnez votre fichier bilan 
matière, entreprise ou synergie. 

 Sélectionnez les colonnes (attributs) à importer puis Ok. 

La table Synergie ne contient pas de données X Y. elle sera 
donc liée par l’assistant à la couche Entreprise grâce à un 
identifiant commun. 

 

 

II - Prototypes COMETHE 

II.A. Configuration : «  » 

La configuration de l’outil permet à l’utilisateur de spécifier l’identifiant commun entre la table 
entreprise et la table synergie. 

On a vu que la table synergie ne possédait pas d’information géographique, il faut donc la lier à une 
table qui possède cette géolocalisation. Ce lien doit se faire sur un attribut commun, parfaitement 
identique. Cela peut être le nom de l’entreprise, le code SIRET, ou tout autre identifiant local.  

Travaillant avec la base Presteo©, on peut se permettre de faire se lien sur l’attribut NOM. Cela 
pourrait être délicat dans d’autres circonstances, la nomenclature des noms n’étant pas toujours 
respectée. 

Lancez l’application à l’aide de l’icône  

Sélectionnez la table « synergie » et 
« entreprise » sur la partie gauche, puis à droite le 
nom des colonnes contenant l’identifiant commun. 
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II.B. Assistant Bilan Matière - 

Cet assistant va vous permettre de rapidement créer une carte sur la base des données importées et 
de vos fonds de plan ou de fonds de plans globaux. 

Lancez l’application à l’aide de l’icône :  

 

 

 

 

L’assistant se découpe en 6 parties distinctes : 

II.B.1. La donnée de base  

Vous devez en premier lieu sélectionner la couche que vous avez apportée et peut être renommée 
dans la partie précédente. Vous ne retrouvez dans cette liste que les données sous forme de carte. Si 
vous ne retrouvez pas votre donnée ici, repassez à l’étape d’import des couches Bilan Matières. 

  
II.B.2. Application du correctif  

Les données que vous importez de Presteo© et que vous localisez à l’aide des colonnes X et Y de la 
table comportent souvent quelques entreprises mal positionnées. Ces erreurs souvent très grossières 
sont détectables à l’œil soit en affichant la carte soit en classant les données par la colonne X ou Y. 
En France les coordonnées sont en général proche de (600'000 ; 200'000), on peut ainsi détecter des 
erreurs de type : 

- 1 ou 111 à la place de 200000 
- 2600000 à la place de 600000 
- … 
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II.B.3. Définition de la couleur  

Les données Presteo© comporte une donnée attributaire « sens » permettant de définir si la matière 
arrive à l’entreprise ou en repart. Nous allons donc nous appuyer sur cette donnée pour représenter le 
bilan d’une couleur différente en fonction du sens. Cette couleur est à définir. 

II.B.4. Choix du fond de plan  

Manifold offre le choix entre plusieurs fond de plan globaux, disponible sur l’ensemble du globe et 
affichant une représentation du territoire adaptée au zoom choisi. Nous avons le choix entre 5 fonds  
de plan : 

- Virtual Earth – Equivalent Microsoft de Google Earth 
o  Plan routier  
o Vue satellite 

- Open Street Map – Wiki cartographique, libre et collaboratif.  
o MapNik 
o Cloudmark 
o Osmarender 

Vous pouvez en sélectionner plusieurs si vous le souhaitez mais cela va ralentir votre navigation. Ces 
fonds de cartes sont téléchargés via Internet à la demande. 

  
II.B.5. Choix d’un fond de plan personnalise  

Si vous cochez cette case cela va désactiver les éventuels fond de plan globaux sélectionné pour les 
remplacer par une carte prédéfinie à l’avance, basées sur des données propre au territoire. Cette 
carte doit être créée auparavant comme expliqué au point II-A-2. Cochez la case puis sélectionnez 
votre carte. 

II.B.6. Nommez votre nouvelle carte  

Donnez un nom à la carte qui va être créé. Si le nom existe déjà vous aurez la possibilité de la 
remplacer ou de renommer votre carte. Si vous souhaitez ajouter votre bilan matière à une carte 
existante, utilisez l’option ci-dessus. 

La carte doit s’ouvrir à la fin du processus et se range automatiquement dans le dossier « _Cartes > 
_Cartes Bilan ». 

La carte peut ensuite être améliorée à l’aide de l’édition thématique afin, par exemple, de définir la 
taille des points en fonction d’un attribut. Cette fonction est détaillée au point I-A-3. 
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II.C. Assistant Synergie  -  
Cet assistant va vous permettre de rapidement créer une carte sur la base des données importées et 
de vos fonds de plan ou de fonds de plans globaux. 

Lancez l’application à l’aide de l’icône :  

 

 

 

 

 

L’assistant se découpe en 7 parties distinctes : 

 

II.C.1. La donnée de base  
Vous devez en premier lieu sélectionner la table contenant la description de vos synergies. Les 
données importantes de cette table sont les noms des 2 entreprises concernées, les autres 
informations sont facultatives. En cas de synergie concernant plus de deux entreprises, il est 
nécessaire de dupliquer la synergie pour chaque couple. Vous ne retrouvez dans cette liste que les 
données sous forme de table. Si vous ne retrouvez pas votre donnée ici, repassez à l’étape d’import 
des Synergies. 

 

II.C.2. Application du correctif  
De la même façon que pour les bilans matières on peut appliquer le correctif sur la couche 
« entreprise de référence ». Les données synergies ne comporte pas de données X et Y, c’est pour 
cela qu’on les lie à une table « entreprise » qui, elle, contient leur position géographique.  
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II.C.3. Définition de la couleur  

Définissez la couleur de la représentation de la synergie. 

 

II.C.4. Synergies à visualiser  

Si vous importez un grand nombre de synergie au sein d’une même table vous pouvez sélectionner 
celles que vous souhaitez visualiser. 

Cliquez sur Sélection, cette fenêtre s’ouvre pour 
vous indiquez la manipulation à faire : 

Pour sélectionner les synergies et éditer la valeur 
de la colonne « Visualiser », il conviendra de suivre 
la démarche suivante : 

- Remise à 0 de l’ensemble des synergies : dans la table, tapez « Ctrl + A » pour tout 
sélectionner puis tapez 0 dans la colonne « visualiser » d’une des lignes sélectionnées. Les 
autres lignes sélectionnées vont hériter de la valeur. 

- Utilisez cette barre d’outils et l’icône surligné pour vider la sélection : 

 
- Pour une sélection selon un critère précis, utilisez la barre de sélection en bas de la page : 

Choisissez la colonne, le critère et la 
valeur puis faites Select.  

- Pour ajouter une série de ligne manuellement faites « Shift + clic », et pour sélectionner des 

lignes indépendantes, activer la fonction « Select Add » :  
- Tapez « 1 » sur une ligne sélectionnée pour remplir les cases sélectionnées. 

 

II.C.5. Choix du fond de plan  

Comme pour les bilans matière vous pouvez sélectionner un ou plusieurs fonds de plan globaux. 

 

II.C.6. Choix d’un fond de plan personnalise  

Si vous cochez cette case, elle désactive les éventuels fond de plan globaux sélectionnés pour les 
remplacer par une carte prédéfinie à l’avance, basées sur des données propre au territoire. Cette 
carte doit être créée auparavant comme expliqué au point I-A-2. Cochez la case puis sélectionnez 
votre carte. 

 

II.C.7. Nommez votre nouvelle carte  

Donnez un nom à la carte qui va être créé. Si le nom existe déjà vous aurez la possibilité de la 
remplacer ou de renommer votre carte. Si vous souhaitez ajouter votre bilan matière à une carte 
existante, utilisez l’option ci-dessus. 

La carte doit s’ouvrir à la fin du processus et se range automatiquement dans le dossier « _Cartes > 
_Cartes Synergie ».  

La carte peut ensuite être améliorée à l’aide de l’édition thématique afin, par exemple, de mettre des 
flèches et de dimensionner sa taille en fonction d’un attribut. Cette fonction est détaillée au point I-A-2. 
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QUELQUES CLES POUR L’UTILISATION DE MANIFOLD® 

 
I. Premières étapes 
 
Ouvrir le logiciel Manifold  
 
            New           Open        Save  
 

 
 

 
II. Importer des fonds vectoriels  
 
Importer les données  
 
La marche à suivre est la suivante : 
 

File>Import>Drawing>Sélectionner le fichier>Ouvrir 
 
N.B. : Plusieurs formats existent, le plus courant sera le format .shp, à sélectionner dans le menu 
déroulant Fichiers de type  
 

Import …file>OK 
 
Dès lors les composants du projet apparaissent dans l’arborescence du projet.  
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S’approprier l’interface  

 Composants 
 
  

                  Barre de Menu Icones d’outils 
 

  
 
 
 Barre de sélection des couches  
                                                             
 
 
 
                                                                Zone d’affichage                                  Arborescence du projet 
 
 Barre d’outils 
Quelques définitions  
 
Barre menu  : donne accès à toutes les fonctions mises à disposition pour gérer le projet en cours 
d’élaboration, ainsi que les composants actifs. 
 
Icones outils  : permettent d’accéder directement aux fonctions sans passer par les menus. 
 
Arborescence du projet  (project pane) : permet de gérer les composants et sous-composants du 
projet en cours. Des dossiers peuvent être créés pour organiser le travail. 
 
Barre d’état  : affiche l’état des composants actifs en temps réel. Par exemple le système de 
projection et les coordonnées du curseur. 
 
Barre de sélection des couches  : permet de changer leur ordre de superposition et de les 
sélectionner. 



Module 3 – Définir les scenarios de mise en œuvre 

 

 22 

III. Créer un projet 
 
Les différents composants d’un projet sont présentés dans la barre d’outils suivante : 
 
 Démarrer un script 
 Effacer  
   Rafraichir 

 Ouvrir  
 
 
 Ouvrir dans une nouvelle fenêtre  Ajouter 
 
 
 
Chart  : Graphiques 
Comments : Commentaires  
Drawing : Structure de stockage de l’information vectorielle 
Form : Interface personnalisée associée à un script 
Image : Structure de stockage de type image 
Labels : positionnements des écritures/Associé ou non à un drawing 
Layout : Mise en page pour impression 
Map: Outil de représentation multi-couches/Peut intégrer des composants drawing, labels image et 
surface 
Palette : Définition des couleurs/Associé ou non à une image 
Query : Requêtes SQL 
Script : Scripts Visual Basic ou Javascript 
Surface : Structure de stockage de l’information de type raster 
Table : Structure de stockage des attributs 
Terrain : Modèle de surface en 3D/Associé à un fichier de surface 
Folder  : Dossier de projet qui structure l’arborescence/Peut contenir tout type de composant 
 
 
Le projet créé, il convient de s’approprier les différentes fonctionnalités de l’outil Manifold®. 
 
Créer une carte  

 
Create>Map>Select (sélectionner les couches nécessa ires)>OK 

 
Gestion des couches  
 

Barre de sélection des couches>Faire glisser les co uches 
 
Sélection d’une couche  
 

Cliquer sur une couche 
Changer la couleur d’un élément  
 

Sélection de la couche>Sélection de l’icône de l’ob jet à modifier>Choix de la couleur 
  
    Area     Area Border               Line                   Point 
 

 
 
Foreground                                                                                         Point rotation angle 
                    Style                       Size 
 
                  Background 
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Trois primitives graphiques  sont disponibles: le polygone , la ligne  et le point . A cela s’ajoute le 
contour des polygones (Area Border). 
 
Il est possible pour chaque primitive de modifier :  

- La couleur du premier plan (cas ou le style de la primitive est du type hachuré par 
exemple) ; 

- La couleur d’arrière plan ; 
- Le style de la forme par exemple : 
- La taille. 
                     
 
 
 
 

    
 
Affichage des attributs  
 

Double clics sur l’élément>Object Fields>Show Blank s/Show Intrisics/Show Read-Only 
 

 
Ouverture d’une table  
 

Double clics sur la table 
 
N.B.: La sélection d’un objet sur la carte ou dans la table est simultanée. 
 
 

IV. Créer une cartographie à l’aide d’une image Ras ter / Créer des 
couches de dessin 
 
Importer une image  
 

File>Import>Image>Sélectionner l’image à importer 
 
N.B. : On peut notamment importer une image à partir de Google Earth ou Google Map grâce à une 
capture écran. 
 
Géo-référencement de l’image  
 
Il s’agit de trouver le centre de l’image, puis de rechercher ses coordonnées géographiques sur 
Google Earth. 
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Recherche du lieu Point de référence               Coordonnées spatiales 
 
 

The projection of this component has not been verif ied. Click here to verify it…>Assign 
Projection>Center Latitude>Entrer la latitude 

 
On procèdera de la même manière pour la longitude.  
 
Création d’une couche de dessin  
 

Create>Drawing>Nommer 
 
Création d’une carte  
 

Create Map>Sélectionner la couche et l’image>OK>Ouv rir la carte 
 
Création d’objet géographique :  
 

Sélectionner la couche>Barre d’outil> 
 
 Insert Area 
 Insert Line Insert Circle 
 Insert Point 
                          Create Insert Ellipse 
 

 
 
          Area                            Insert Box Insert Geographic Circle 
                    Line     Point Insert Box on Center 
 
 
N.B.: A l’aide de l’outil Insert Geographic Circle il est possible de créer un point selon des 
coordonnées géographiques prédéfinies. 
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V. Manipuler des tables et création de colonnes 
 
Création colonnes  

 
Ouvrir la table>Table>Add>Column 

 

 
 
 
 

  
  
                        Lien URL 
 
Relations entre table (clé de jointure)  
 
Il faut au préalable s’assurer qu’une clé de jointure est prédéfinie. 
 

Table>Relations>Add relations>Match key field in (s électionner la table à 
associer)>Sélectionner la clé de jointure>Ok 

 

Données chiffrées 

Données « texte » 

Oui/Non 
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                                   Liaison entre table 
 

 
 
 
 
 Table à joindre 
 

 
 
                               Clé de jointure 

 

VI. Créer un label 
 
Un label  correspond à une « étiquette » liée à un objet géographique. 
 
Création de labels  
 

Create>Labels>Donner un nom>Parent (choisir l’éléme nt à lier)>Columns (Sélectionner la 
colonne dont on souhaite faire apparaître les noms par un double clic)>Intégrer le label à la 

barre des couches 
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Mise en page des labels  

 
 

 Positionnement de la zone de texte 
Taille Rotation 

 
 

 
Style de police Format de la zone  
       de texte 
 

VII. Insérer des informations supplémentaires 
 
Afin de renseigner plusieurs informations essentielles, il est nécessaire de passer par cette étape. 
 
Insérer une légende  
 

View>Legend     
 
 Il est possible de sélectionner la position de la légende sur la carte, le format mais également les 
informations qui doivent apparaître : 
 

Customize legend>Insérer ou supprimer des éléments 
 
N.B. : pour ne pas surcharger la carte il est recommandé de ne conserver que les données qui sont 
nécessaires à la compréhension de l’information  
 
Insérer une rose des vents  
 

View>North arrow  
 
Tout comme pour la légende, il est possible de choisir la position et le format de la rose. 
 
Insérer l’échelle  
 

View>Scale Bar 
 

VIII. Mettre en page 
 
Dès lors que la carte semble complète, il est nécessaire de s’occuper de la mise en page.  
 

Créer un composant>Layout>Renommer>Choisir le compo sant Map à représenter 
 
A partir de cette étape il est possible à nouveau d’intégrer une rose des vents, une légende ou encore 
une barre d’échelle. Cependant c’est à ce niveau qu’il est possible d’intégrer des textes 
supplémentaires (à partir des outils d’insertion) comme un titre, la source de la carte, le logiciel utilisé 
pour la réaliser et l’auteur/structure. 
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IX. Exporter et enregistrer 
 
Créer une image  
 

Tools>Make image>Name (donne un titre au fichier)>P aint (permet de choisir la zone 
d’affichage) 

 

 
 
 

 
Exporter un fichier  
 

Dans l’arborescence du projet>Sélectionner le fichi er (clic droit)>Export 
File>Export>…  

 
 
 

Enregistrement des données  
 

File>Save>Format .map par défaut 
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GLOSSAIRE 
 
 
Adressage :   Système d’adresses des entreprises dans la ZIP mis en place par le port et 

qui va être réorganisé prochainement. 
 
Bilan matière :   Bilan de l’ensemble des flux entrants et sortants dans le système d’une 

entreprise. 
 
Chaîne trophique  : Chaîne alimentaire, divisé en trois principaux niveaux, producteur, 

consommateur et décomposeur. 
 
Clé de jointure :  Combinaison des enregistrements de deux tables disposant de valeurs 

correspondantes dans une colonne donnée de chaque table. 
 
Données attributaires : Données associées à un objet ou une localisation géographique, soit pour 

décrire un objet géographique, soit pour localiser des informations 
 
Données spatiales :   Données qui renvoient à la localisation et à la forme des objets. 
 
Ecosystème :  Ensemble formé par une association ou communauté d’êtres vivants en son 

environnement. Les éléments qui le constituent développent un réseau 
d’interdépendance. 

  
Ecologie Industrielle :  Composante opérationnelle du développement durable qui prône une 

approche systémique des activités, inspirée des écosystèmes naturels  
 
Input :   Flux de matière entrant 
 
Output :   Flux de matière sortant 
 
SIG : Un Système d’Information Géographique est un outil informatique permettant 

de présenter des données alphanumériques spatialement référencées, ainsi 
que de produire des plans et des cartes. 

 
SQL :  Structured Query Language ou langage structuré de requêtes est un pseudo-

language informatique (de type requête) standard et normalisé, destiné à 
interroger ou à manipuler une base de donnée relationnelle. 

 
Table :   Tableau d’organisation des données 
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Fiche action 20:  

Prise de décision et définition d’un plan d'action 

 

OBJECTIFS 

L'objectif est de :  

- faire la  synthèse des résultats  obtenus dans le module, devant éclairer la prise de décision 
- engager la prise de décision  proprement dite sur les actions et le rôle des parties prenantes 
- préparer la mise en œuvre  concrète des actions et ses modalités 

 

Après l'évaluation et l'analyse multicritère des différentes actions ou des scenarios pour leur mise en 
œuvre, il convient de décider des suites à donner aux projets, qu’il s’agisse de projets d’entreprises  
ou de projets de territoire  engageant plus largement les acteurs publics.  

Des études techniques complémentaires  peuvent éventuellement être nécessaires pour la 
réalisation concrète des projets, qu’il s’agisse de solutions de mutualisation interentreprises, de 
solutions de valorisation de coproduits, de développement d’activités, d’équipements partagés ou de 
services. 

Par ailleurs, une réflexion doit aussi être portée sur la continuité et les formes de portage 
possibles de la démarche collective  ou d’actions communes spécifiques.   
 

METHODE 

Une réunion rassemblant le comité de pilotage et le s entreprise peut être organisée, ou encore 
une réunion par action réunissant les parties prenantes, animées par exemple par les acteurs ayant 
piloté les études de faisabilité  liées à ces actions, afin d’engager collectivement la prise de décision. 
Une rétrospective du projet et des études menées est réalisée en rappelant les enjeux. 

Les résultats de l'analyse multicritère et le SIG , en proposant une représentation cartographique 
des scenarii analysés, peuvent être  utilisés comme une base de discussion  et comme un outil 
d'animation . L'analyse multicritère ne propose pas une solution idéale mais un ensemble ordonné de 
scenarii analysés et des arguments pour justifier un choix de développement économique local ou une 
forme opérationnelle de synergie interentreprises.  

Enfin, la définition d’un plan d’action  permet de mettre en face de chaque action les acteurs 
concernés,  les moyens techniques, financiers et humains requis , de planifier les tâches  
précises à réaliser (maitrise d’œuvre…), le calendrier prévisionnel  et le rôle des parties prenantes  
dans la réalisation de ces actions. 

 

OUTILS  

- Outils d'animation :  

o supports de présentation 
o illustrations SIG 
o illustrations issues de l’analyse multicritère 

- Grille Plan d’action  
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 Grille Plan d’action 

Type de 

synergie 
flux synergie 

Tâches et/ou  

études complémentaires à réaliser 

Complexité 

(+ ; +/- ; -) 

Temporalité de 

mise en œuvre 

(CT/MT/LT) 

Acteurs concernés  

(noms et nombre) 

Acteurs de la maitrise 

d’ouvrage/des études 

Niveau 

de 

priorité 

        

        

        

        

Substitution/ 

valorisation 

matière ou 

énergie 

        

        

        

        

        

Mutualisation 

amont  

(achats…)  

ou aval  

(collecte 

déchets…) 

        

        

        

        

        

Développement 

de services, 

d’activités, 

d’équipements 
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 Exemple d’actions engagées sur les territoires COM ETHE 

  
 

 

Territoires 
COMETHE Actions initiées (groupes de travail thématiques, é tudes techniques, mise en œuvre effective…) 

Territoire Aubois  - Réutilisation d’eau et récupération des calories des effluents avec un industriel papetier 

Territoire 
Dunkerquois  

- Mutualisation de la collecte et valorisation locale des déchets fermentescibles 
- Achat groupé de papier de bureau 
- Entretien mutualisé des séparateurs d’hydrocarbures 

Site portuaire CNR du 
Pouzin (Ardèche) 

- Permis d’aménager du site intégrant l’écologie industrielle (services mutualisés, massification de flux de 
transport, etc.) 

Espace économique 
Métropole Savoie  

- Mutualisation d’achats (produits d’entretien, produits agroalimentaires…) 
- Projet d’engrais normalisé à base de sous produits agrégés (fientes, etc.),  
- Réseau de chaleur et d’air comprimé 

ZI Lagny-sur-Marne 
- Valorisation de déchets de béton 
- Valorisation d’eau industrielle à l’étude 

 

 


